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About this user’s guide

This user’s guide provides instructions for using IBM® PowerExecutive software
to manage the power and thermal needs of BladeCenter® systems and
rack-mounted servers in the data center. PowerExecutive is part of a larger
power-management implementation that includes hardware and firmware
components. PowerExecutive 2.10 is an extension to IBM Director 5.20 software. A
stand-alone version of PowerExecutive, which runs on top of the Embedded
Director console, is also available.

Who should read this user’s guide

This user’s guide is for system administrators and operators using PowerExecutive
from IBM Director Console to manage the power and thermal needs of
BladeCenter systems and rack-mounted servers in the data center.

Conventions and terminology

These notices are designed to highlight key information:
Note: These notices provide important tips, guidance or advice.

Important: These notices provide information or advice that might help you avoid
inconvenient or difficult situations.

Attention: These notices indicate possible damage to programs, devices or data.
An attention notice appears before the instruction or situation in which damage
can occur.

Related information
This topic provides links to additional information related to PowerExecutive.
PowerExecutive resources on the World Wide Web
The following Web pages provide resources for understanding, using and

troubleshooting PowerExecutive and other systems-management tools.

PowerExecutive Web site
www.ibm.com/servers/eserver/xseries/systems_management/
ibm_director/extensions/powerexec.html

Obtain an overview of PowerExecutive and links to download the product,
release notes and user’s guide.

IBM Systems: Technical support page
www-304.ibm.com/jct01004c/systems/support/

Locate support for IBM hardware and systems-management software.

IBM Systems Management Software: Download/Electronic Support page
www.ibm.com/servers/eserver/xseries/systems_management/
ibm_director/
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Download IBM systems-management software, including PowerExecutive.
Check this Web page regularly for new PowerExecutive releases and
updates.

IBM System x° Systems Management page
www.ibm.com/systems/x/

Obtain an overview of IBM systems management.

IBM ServerProven® page
www-03.ibm.com/servers/eserver/serverproven/compat/us/

Obtain information about IBM System X, IBM eServer and IBM
BladeCenter.

How to send your comments

Your feedback is important in helping to provide the most accurate and highest
quality information. If you have any comments about this book or any other IBM
publication, use the form for reader’s comments that is provided at the back of this
publication. If the form has been removed, address your comments to:

International Business Machines Corporation
Design & Information Development
Department CGFA

PO Box 12195

Research Triangle Park, NC 27709-9990
US.A.

Accessibility

Accessibility features help a user who has a physical disability, such as restricted
mobility or limited vision, to use information technology products successfully.

Features

PowerExecutive meets the accessibility standards for Section 508 of the US
Rehabilitation Act.

These are the major accessibility features in PowerExecutive:

* You can use screen-reader software and a digital speech synthesizer to hear what
is displayed on the screen.

* You can operate all features using the keyboard instead of the mouse.

* You can choose from a variety of high-contrast color schemes and large font
sizes in the IBM Director Console.

PowerExecutive supports all accessibility features provided by IBM Director.
Keyboard navigation

This product uses standard Microsoft® Windows® and Java™ navigation keys.
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Chapter 1. Getting started

Before getting started, you should become familiar with general and conceptual
information about PowerExecutive.

PowerExecutive overview

PowerExecutive is an IBM Director extension that provides the PowerExecutive
task in an IBM Director environment.

The PowerExecutive task displays the PowerExecutive Console in IBM Director
Console. PowerExecutive enables you to monitor and collect power-consumption
data from IBM BladeCenter chassis and rack-mounted servers, manage trend data,
and export data.

Additionally, the information in PowerExecutive is affected by certain events. For
more information, see [“Events that affect PowerExecutive” on page 33/

PowerExecutive task overview

Use PowerExecutive to monitor and collect power consumption data from
supported BladeCenter systems and rack-mounted servers, manage trend data, and
export data from PowerExecutive.

Tip: For more information about the PowerExecutive task, see ["PowerExecutive|
[task” on page 4|

Icon [

Supported IBM BladeCenter Chassis and rack-mounted server Director-managed
Director objects objects

Supported operating * Linux®

systems * Microsoft Windows

For detailed operating-system support information, see the IBM
PowerExecutive Installation and User’s Guide.

Availability Extension to the IBM Director product. You can download the
extension from the IBM Director Web site at |Ettp:/ / |
[www.ibm.com/systems/management/ director/index.html}

Required hardware or | For installation, none. For monitoring, this task only supports
hardware limitations specific BladeCenter systems and rack-mounted servers. For
details, see the IBM PowerExecutive Installation and User’s Guide.

Required software BladeCenter Management extension to IBM Director 5.20 must be
installed.

Required protocols None

Required device None

drivers

Mass configuration None

support

Scheduler support None

© Copyright IBM Corp. 2005, 2006, 2007 1
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Files associated with
this task

None

Events associated with
this task

None, but the information displayed by PowerExecutive is
affected by some events. For more information, see the IBM
PowerExecutive Installation and User’s Guide.

PowerExecutive terminology

PowerExecutive uses terminology that is specific to power management in IBM

Director Console.

The hardware in a PowerExecutive environment is referred to in the following

ways:

* A management server is a server on which both IBM Director Server and
PowerExecutive Server are installed.

* A management console is a system on which both IBM Director Console and
PowerExecutive Console are installed.

A BladeCenter system consists of a chassis and a number of modules. The chassis
is the physical enclosure that houses the modules. The modules are the
individual components, such as blade servers and blowers, that are inserted into

bays in the chassis.

* A rack-mounted server is a stand-alone system with a Baseboard Management

Controller (BMC).

* A managed system is either a BladeCenter system or a rack-mounted server in an
IBM Director environment.

* A module, as already described under BladeCenter system, is a BladeCenter
component that is inserted in a bay in a BladeCenter chassis. The management
module and blade server are two types of modules you can insert in a

BladeCenter chassis:

— A management module is the BladeCenter component that handles
system-management functions. It configures the BladeCenter chassis and
switch modules, communicates with the blade servers and all I/O modules,
multiplexes the keyboard/video/mouse (KVM), and monitors critical
information about the chassis and blade servers.

— A blade server is a complete compute node with some combination of
processors, memory, and network interfaces, with supporting hardware and
firmware. The blade server may occupy one or more slots in a BladeCenter

chassis.

In addition to a management module and blade server, a BladeCenter chassis
can also contain the following modules:

— Power modules
— I/O modules

— Blower modules
— Media trays

— Midplanes

2 IBM PowerExecutive Installation and User's Guide




PowerExecutive components

This topic provides information about the PowerExecutive components.

PowerExecutive comprises the following three components:
* PowerExecutive Server
* PowerExecutive Console

e PowerExecutive Database

PowerExecutive Server

PowerExecutive Server maintains the PowerExecutive environment and manages
all PowerExecutive operations.

PowerExecutive Server communicates out-of-band with each managed system to
collect power information. In the case of a BladeCenter chassis, it communicates
with the management module in the chassis. In the case of a rack-mounted server,
it communicates with the BMC.

PowerExecutive Server also communicates with Director Server to provide event
filtering and event actions that support IBM Director event action plans, and
communicates with Director Console to display status and allow the user to
perform operations. You must install PowerExecutive Server on the management
server. When you install PowerExecutive Server, PowerExecutive Console is
installed automatically.

Power data is collected only while the PowerExecutive Server is running. When
you install PowerExecutive, the server starts running. It runs whenever the IBM
Director Service is running. It collects data on the BladeCenter chassis and
rack-mounted servers every minute, or as configured on the Manage Trend Data
window in the graphical user interface (GUI).

PowerExecutive Console

PowerExecutive Console provides the GUI to PowerExecutive in IBM Director
Console.

PowerExecutive Console displays rack-mounted servers and BladeCenter chassis at
the same level in the navigation tree. Rack-mounted servers are represented by leaf
nodes (lowest point in the tree), while BladeCenter chassis have sub-nodes
representing the power domains and modules within the chassis.

Install PowerExecutive Console on all management consoles from which a system
administrator remotely accesses the management server and performs
PowerExecutive tasks.

PowerExecutive Database

The PowerExecutive Database stores information collected by PowerExecutive
Server.

PowerExecutive saves configuration information and historical power and
temperature data for managed systems in a Derby database. The PowerExecutive
Database is created in the Data subdirectory of the IBM Director installation
directory.
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When you uninstall IBM Director Server, it does not remove the PowerExecutive
Database unless you request that customizations be deleted during the
uninstallation of IBM Director Server.

The size of the PowerExecutive Database directly correlates to the short-term
data-collection interval, the long-term data-collection interval, and the number of
days that short-term and long-term trend data is kept. All of these values are
configurable. You can control them and the size of the PowerExecutive Database
by using the Manage Trend Data window. For information about doing so, see
[“Managing collection of trend data” on page 30,

PowerExecutive task

4

You use the PowerExecutive task to launch the PowerExecutive GUI. You can use
the PowerExecutive task to view and monitor power consumption on various
rack-mounted servers and BladeCenter chassis in the IBM Director environment.

When you install the PowerExecutive extension in your IBM Director environment,
the PowerExecutive task is added to IBM Director Console.

You can start the PowerExecutive task by dragging and dropping the task icon
onto the following targets:

e If the target is a blade server, the display consists of the BladeCenter chassis
containing the blade with the targeted blade preselected.

* If the target is a BladeCenter chassis, the display consists of the chassis with the
chassis itself preselected.

e If the target is a rack-mounted server, the display consists of the server with the
server itself preselected.

e If the target is a group of rack-mounted servers or BladeCenter chassis, or both,
the display consists of all chassis or rack-mounted servers in the group with the
first chassis or server in the group preselected.

If there is no target (you start the PowerExecutive task by double-clicking rather
than dragging and dropping it onto a target), then the display consists of all
power-managed BladeCenter chassis and rack-mounted servers known to Director.

You can perform the following tasks for rack-mounted servers, BladeCenter chassis
and components:

* Monitor power consumption data
* Collect power consumption data
* Manage trend data

* Export data

* Set power cap

More information about these tasks is provided in [Chapter 3, “Using|
[PowerExecutive,” on page 19

Start PowerExecutive for all managed systems

When you start PowerExecutive with no target, the PowerExecutive window opens
and displays a tree of all power-managed systems on IBM Director Server. The
advantage of starting PowerExecutive in this manner is that you can manage all
managed systems from one window.

IBM PowerExecutive Installation and User's Guide



Start PowerExecutive for some managed systems

When you start PowerExecutive for only a managed system or a group of
managed systems, the PowerExecutive window opens and displays a tree of only
the selected objects.

The left pane in PowerExecutive contains only the selected managed systems, only
those chassis that contain the blade servers that have also been selected, and only
the managed systems in a selected group. When you select a blade server,
PowerExecutive determines the containing chassis and displays the entire tree
structure for that chassis, not just the blade server that you selected.

The advantage of starting PowerExecutive in this manner is that you see only the
subset of managed systems that you are interested in. The disadvantage is that you
can manage only those managed systems that were selected when you started
PowerExecutive. If you need to manage other managed systems at a later time,
you must start another PowerExecutive task for those additional managed systems.

PowerExecutive Console window

After you start the PowerExecutive task, the PowerExecutive Console opens and
provides a GUI for managing selected rack-mounted servers and
BladeCentersystems on the management server.

The PowerExecutive Console window contains a menu bar, a tool bar and a
graphical representation of the managed systems that were selected. It also
includes power consumption data on various rack servers, BladeCenter chassis,
and power domains and modules in these chassis. The PowerExecutive window
displays only those managed systems for which it was started, which might not be
all managed systems on the management server.

You can force the window to refresh in different ways, as explained in |“Refreshing
[the PowerExecutive Console” on page 9/

The PowerExecutive Console contains these major areas:
* Navigation pane

* Current Data pane

¢ Trend Data pane

Navigation pane

Use the Navigation pane to select the managed system for which the
PowerExecutive Console displays information.

The left side of the PowerExecutive Console contains the Navigation pane, which

displays the systems currently targeted by PowerExecutive in a tree structure. Each

node in the structure represents a managed system that is managed by

PowerExecutive. There is always a root node with three child nodes:

* The root node is labeled All Systems if you launch the Console by
double-clicking the PowerExecutive task, or Selected Systems if you launch the
Console by targeting a specific group or system.

* One child node labeled Power-Managed Systems (ac) represents the group
consisting of all currently targeted rack-mounted servers or BladeCenter chassis
that draw ac power and support power metering.
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* One child node labeled Power-Managed Systems (dc) represents the group
consisting of all currently targeted rack-mounted servers or BladeCenter chassis
that draw dc power and support power metering.

* The other child node labeled Other Systems represents the group consisting of all
currently targeted rack-mounted servers that don’t support power metering.

Attention: If the node labeled Other Systems is selected in the navigation tree, the
Current Data and Trend Data panes display a message that no information is
available for that system.

When you expand an individual BladeCenter chassis within the Navigation pane,
the tree structure shows folders that identify the power domains in the
BladeCenter chassis. Under each power domain folder are various components
within that power domain, such as the following objects:

* Power modules

* Blade servers

* I/O modules

* Management modules

* Blower modules

* Media trays

* Midplanes

When you select one of these components, PowerExecutive updates the Current
Data pane and the Trend Data pane to display information about the one that you
selected.

Current Data pane

Use the Current Data pane to view information about a selected managed system.

The upper right side of the window contains the Current Data pane, which uses a
table to display information about the managed system that is currently selected in
the tree structure.

The rows and columns in the table change with the object that is selected:

* If you select a group of managed systems in the Navigation pane, the Current
Data pane displays rows about the managed systems in that group and columns
with information about those managed systems.

* If you select a rack-mounted server in the Navigation pane, the Current Data
pane displays information about that server.

* If you select a BladeCenter chassis in the Navigation pane, the Current Data
pane displays rows about the power domains in the chassis and columns with
information about those power domains.

 If you select a power domain in the Navigation pane, the Current Data pane
displays rows about the BladeCenter components in that power domain and
columns with information about those components.

* If you select a module within a power domain in the Navigation pane, the
Current Data pane displays information about that module.

For information about the columns and fields in the tables of the Current Data
pane, see [“Monitoring power-consumption data” on page 19|

PowerExecutive updates the information in the Current Data pane when new
information becomes available, which is generally once per data collection interval.
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Trend

The default is every minute, but this data-collection interval can be customized.
For more information, see [“Managing collection of trend data” on page 30

You can use PowerExecutive to export the information in the Current Data pane.
For more information, see [“Exporting current data” on page 32

Data pane

Use the Trend Data pane to view information about historical power consumption
for a selected managed system.

The lower right side of the window contains the Trend Data pane, which provides
a graphical or tabular view of power data over time about the managed system
that is currently selected in the tree structure. The display is controlled by the View
| Show Trend Data as Chart and View | Show Trend Data as Table menu items or the
Show Trend Data as Chart and Show Trend Data as Table tool bar buttons).

The time range for the displayed trend data is indicated by the interval list box.
You can select one of the predefined data ranges or create a custom trend data
interval. For more information, see [“Creating a custom time interval for the Trend|
[Data pane” on page 31

The predefined data ranges are as follows:
* Last hour

e Last 12 hours

e Last 24 hours

* Last 48 hours

* Last week

* Last 2 weeks

* Last month

* Last 6 months

e Last year

The Trend Data chart consists of two sub-charts, which are always displayed. The
upper chart displays power data and the lower chart displays temperature and
CPU throttling data. The two sub-charts share the same time axis. A legend
identifying the various chart elements appears above the upper sub-chart. The
check boxes in the legend control the display of individual chart elements to be
enabled or disabled.

The upper chart displays average power (ac and dc) over time, along with the
Pcap (current power cap), Pcap_max (maximum power cap), and Pcap_min
(minimum power cap). Optionally, upper and lower percentiles for average power
(dc) can be set, with the range between the upper and lower percentile displayed
in light blue. An upper percentile of 90%, for example, sets the upper end of the
range to the smallest power value such that at least 90% of the hits in the power
histogram are below that value. A lower percentile of 10% sets the lower end of the
range to the largest power value such that at least 90% of the hits in the power
histogram are above that value. The default upper percentile is 100%,
corresponding to the maximum power. The default lower percentile is 0%,
corresponding to the minimum power.

The values are displayed in the Trend Data chart in a different color, as shown in
[Table 1 on page 8] For the Trend Data table, this information is put into cells of the
table.
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Table 1. Colors and meanings that are used in Trend Data chart

Chart check
boxes

Displayed in Trend Data
chart as

Description

Average (ac) |Green line The average ac power.

Average (dc) |Blue line The average dc power.

Pcap (dc) Dotted black line The current power cap.
Pcap_max/ Solid black line The maximum and minimum power caps.
Pcap_min

Upper and Shaded light-blue region The range of dc power.

lower

percentile

(dc)

Exhaust Red line The exhaust (outlet) temperature.
temperature

Ambient Blue line The ambient (inlet) temperature.
temperature

Effective CPU | Shaded light-green region The effective CPU speed over time.
speed (%)

Events Red squares, green triangles | Shows the PowerExecutive events that have

and yellow diamonds occurred. Each event has a severity. For more
information, see [“Internal events” on page 34|

The current values for the nameplate power, Pcap_max hot-plug, and Aux power
fields are displayed in text in the upper chart. These are relatively static values
and, therefore, not trended over time, to reduce clutter.

The lower chart displays the ambient and (if available) exhaust temperatures. The
left axis displays the scale for temperature. The lower chart also displays the
effective CPU speed over time, with a value of 100% corresponding to the nominal
speed of the CPUs in the system. Values less than 100% indicate that the CPUs
have been throttled. The upper right corner of the chart displays the nominal CPU
speed. The right axis displays the scale for CPU speeds. The scales for temperature
and CPU speed are independent of one another.

The following events are displayed in both the upper and lower charts:

The upper chart displays changes in the Pcap_max, Pcap, or Pcap_min field
values on the corresponding trend line.

The upper chart displays power-related events on the average power-in-use
trend line.

The lower chart displays temperature-related events on the ambient temperature
trend line (the exhaust temperature is not always available).

The lower chart displays CPU throttle-related events on the effective CPU speed
line.

The bottom axis of the upper chart displays any other events.

The Trend Data table corresponds to the node that is selected in the navigation
tree. The range for the Trend Data table is controlled by the same drop-down list
as for the Trend Data chart. The entire range that is specified in the list box is
available. The table has the following columns.
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Table 2. Descriptions of Trend Data table columns

Column title

Description

Time

The time at which the current data was collected.

Average Watts (ac)

For a rack server, the watts currently being consumed as reported by
the power meter, or “...” if power data is not available. For a
BladeCenter chassis, the sum of the Average Watts (ac) of all power

domains in the chassis, or “...” if power data is not available.

Average Watts (dc)

The dc power that is being consumed as reported by the power

meter, or “...” if power data is not available.

Pcap (dc)

The current power cap.

Upper Percentile
(do)

The upper range of the power-in-use.

Lower Percentile
(do)

The lower range of the power-in-use.

Pcap_max (dc)

The maximum possible power cap.

Pcap_min (dc)

The minimum possible power cap.

°C Exhaust The current exhaust (outlet) temperature.

°C Ambient The current ambient (inlet) temperature.

Effective CPU Speed | The average CPU speed as a percentage of the nominal CPU speed.
(%)

Events The description of an event.

The Time column is always displayed. Check boxes are used to control which
elements display in both the Trend Data chart and table. Each column is controlled
by a single check box, with the exception of the Events column, which is displayed
if any of the Events check boxes (Critical, Warning, or Harmless) is selected.

Customizing the PowerExecutive Console

You can customize the contents of the PowerExecutive Console.

You can control the display of these panes on the PowerExecutive Console:
* Navigation pane

¢ Current Data pane

¢ Trend Data pane

To show or hide one of these panes, use the View menu to check or uncheck the
name of each pane.

When the Trend Data pane is displayed, you can control its display as follows:
* Show the trend data as a chart
¢ Show the trend data as a table

To control these aspects of the Trend Data pane, use the View menu to check or
uncheck each aspect you wish to control.

Refreshing the PowerExecutive Console

You can use the Refresh function to request an update of the information that is
shown in the PowerExecutive Console.
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PowerExecutive obtains its information from persistent storage in IBM Director
Server and then caches the information on the console for subsequent display. See
[“Monitoring power-consumption data” on page 19| for the types of information
that is displayed by PowerExecutive.

By default, the Console view is refreshed automatically once per short-term
data-collection interval. The default is every minute, but you can change this data
collection interval. To configure the short-term data collection interval, see
[“Managing collection of trend data” on page 30,

However, with the Refresh function, you can force a refresh request rather than
waiting for the data collection interval or an event to occur.

To refresh the PowerExecutive Console, click the Refresh icon in the toolbar. If the
management server contains several managed systems that are being displayed,
the refresh operation can take several minutes. Alternatively, you can use the View
+ Refresh menu option.

During the refresh operation, the status line of the PowerExecutive Console
displays the word Refreshing to indicate that the operation is active. After the
refresh operation is complete, the status line displays the word Ready.

Invoking PowerExecutive functions

The functions of PowerExecutive are invoked primarily through the toolbar, the
menu bar or pop-up menus in the PowerExecutive Console.

You can use the menu bar to manage power (set a policy), suspend and resume
data collection, manage trend data, export power information, derate power for
individual managed systems, customize the contents of the PowerExecutive
Console, access the PowerExecutive help system, and close the PowerExecutive
Console. Menu bar operations are explained in [Chapter 3, “Using PowerExecutive,”|

The PowerExecutive toolbar contains the functions that are described in [Table 3

Table 3. Toolbar icons and their actions

Icon Action

Enables or disables collection of trend data for the rack server or
BladeCenter chassis that is selected in the navigation tree. This icon
is only available when the object that is selected in the navigation
tree is a rack server or BladeCenter chassis.

B | o [

Opens a dialog with which you can manage the trend data in the
PowerExecutive database.

Opens a dialog with which you can manage power for rack or blade
servers with power-meter support.

Opens a dialog with which you can specify a derating factor for
non-blade modules or blades with no power-meter support. This
factor is applied to the label power to estimate the power-in-use.

& | |8

Opens a dialog that allows you to display the amount of power
used for a given system or group of systems over a specified period
of time and calculates the corresponding cost of that power.

(&

= Displays trend data in graphical format. This toolbar icon is
available only when the trend data is displayed in tabular format.
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Table 3. Toolbar icons and their actions (continued)

Icon

Action

Displays trend data in tabular format. This toolbar icon is available
only when the trend data is displayed in graphical format.

Refreshes the current Trend Data chart or table.

Chapter 1. Getting started 11
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Chapter 2. Installing PowerExecutive

To install PowerExecutive, review important planning, requirements, and
preparation considerations.

PowerExecutive stand-alone version

A stand-alone version of PowerExecutive is available starting with version 2.00.
The stand-alone version is similar to the extension version, except where
PowerExecutive extension runs on top of the standard Director console, the
stand-alone version runs on top of the Embedded Director console.

Tip: See [[BM Director: Documentation and Resources| (http://www-03.ibm.com/
systems/management/director/resources/) for information about launching
the Director console.

The Embedded Director Console is a streamlined version of the standard Director
Console, supporting only the PowerExecutive extension and related tasks.

Once installed, the PowerExecutive stand-alone version functions exactly the same
as PowerExecutive extension.

Requirements

This topic provides information about PowerExecutive product requirements.

In addition to the requirements that are applicable to IBM Director 5.20,
PowerExecutive has further restrictions regarding the hardware and software with
which it can be used. For information about IBM Director 5.20 requirements, see
the IBM Director Installation and Configuration Guide.

Hardware requirements

There are minimum hardware requirements the system must be meet before you
can install or use PowerExecutive.

Management servers and management consoles
PowerExecutive can be installed on any management server or management
console that supports IBM Director 5.20.

Managed systems
PowerExecutive can monitor power consumption for selected high-end and
high-volume rack servers, BladeCenter chassis and blade servers.

PowerExecutive can monitor these servers:

Table 4. PowerExecutive managed system support

Server Machine Type Power Monitoring |Power Cap
x3550 7978 Yes Yes
x3650 7979 Yes Yes
x3755 8877 Yes No
x3655 7985 Yes No
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Table 4. PowerExecutive managed system support (continued)

Server Machine Type Power Monitoring Power Cap
x460 8872 Yes No
x366 8863 Yes No
HS20 8843 Yes Yes
HS21 7995 Yes Yes
HS21 8853 Yes Yes
HC10 7996 Yes No
LS20 8850 Yes Yes
LS21 7971 Yes No
LS41 7972 Yes Yes

PowerExecutive can monitor these BladeCenter chassis:

* BladeCenter E machine type 8677 (AC and DC powered)
* BladeCenter T machine type 8720 (DC powered)

* BladeCenter T machine type 8730 (AC powered)

* BladeCenter H machine type 7989 (AC powered)

* BladeCenter H machine type 8852 (AC powered)

* BladeCenter HT machine type 8740 (DC powered)

* BladeCenter HT machine type 8750 (AC powered)

Supported operating systems

PowerExecutive is supported for use with IBM Director 5.20 management servers
and management consoles that are running 32-bit operating systems.

PowerExecutive supports a subset of the operating systems supported by IBM
Director. Specifically, these operating systems are supported for Power Executive:

* Windows Server 2003 Enterprise Edition

* Windows Server 2003 Enterprise Edition x64

* Red Hat Enterprise Linux AS, version 4.0, for Intel® x86-64
* Red Hat Enterprise Linux ES, version 4.0, for Intel x86-64
* Red Hat Enterprise Linux AS, version 4.0, for Intel x86

* Red Hat Enterprise Linux ES, version 4.0, for Intel x86

* SUSE LINUX Enterprise Server 9 for x86-64

* SUSE LINUX Enterprise Server 9 for x86

Preparing to install PowerExecutive
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Use this section to ensure that your environment is set up properly for the
installation and use of PowerExecutive.

Prerequisites

Ensure that your system meets all prerequisites before you install and use
PowerExecutive.

You must have the following prerequisites installed before you can install
PowerExecutive:
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* IBM Director 5.20 is installed
* BladeCenter Management extension of IBM Director is installed

Downloading PowerExecutive

Ensure that your environment is set up properly for the installation and use of

PowerExecutive.

Complete the following steps to download PowerExecutive from the IBM Web site:

1. Go to the overview page for PowerExecutive at [www-03.ibm.com/systems /|

[management /director /extensions/powerexec.html[

2. On the bottom of the overview page, click Download IBM PowerExecutive.

3. On the PowerExecutive (plug-in tool for IBM Director) - Systems Management
page, click the file link for the PowerExecutive executable file that you want to

download.

lists the executable files that you can download.

Table 5. PowerExecutive files that can be downloaded

Operating system

PowerExecutive
component

File to download

(PowerExecutive
stand-alone version)

Windows Server or console PowerExecutive 2.10.exe

Linux Server PowerExecutive-server-2.10-2.noarch.rpm
Linux Console PowerExecutive-console-2.10-2.noarch.rpm
Windows Server PowerExecutiveSA 2.10.exe
(PowerExecutive

stand-alone version)

Linux Server PowerExecutiveSA-2.10-1.noarch.rpm

Tip:

You can also download the IBM PowerExecutive 2.10 Readme and the IBM
PowerExecutive Installation and User’s Guide from this page.

4. Copy the downloaded file to a local drive on each management server and
management console on which you want to install PowerExecutive. Be sure
that you copy the correct file based on the operating system that the
management server or management console is using.

Installing PowerExecutive on systems running Windows

Use this section for installing PowerExecutive on systems that are running

Windows.

If you are installing PowerExecutive on systems that are running Linux, see

[“Installing PowerExecutive on systems running Linux” on page 17

Complete the following steps to install PowerExecutive on a system that is running

Windows:

1. If IBM Director Server or IBM Director Console, or both, are running, close

them.
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7.

From the system on which you want to install PowerExecutive, run the
executable file that you downloaded.

Important: The operating-system account that is used to install PowerExecutive
must have at least local Administrator authority.

The PowerExecutive Setup program starts. After several seconds, the Welcome
window opens.

Click Next. The License Agreement window opens.

Read the license agreement, click I accept the terms in the license agreement,
and click Next. The Director Server Control Notification window opens.

Read the notification and click Next. The Ready to Install the Program window
opens.

Click Install.

When you are installing PowerExecutive Console or PowerExecutive Server
when IBM Director Server is not running, the Installing IBM PowerExecutive
window opens. The progress of the installation is displayed.

If this is an upgrade, and the existing PowerExecutive database is from a prior
release, then a warning prompt occurs that indicates that the previous version
of PowerExecutive will no longer be able to access the database once version
2.10 has been started.

Click Finish.

Complete the following steps to install the stand-alone version of PowerExecutive
on a system that is running Windows:

1.

The stand-alone version cannot be installed on a system that has the IBM
Director Console or Server already installed. Ensure that neither the IBM
Director Console nor Server are installed on this system.

From the system on which you want to install PowerExecutive, run the
executable file that you downloaded.

The operating-system account that is used to install PowerExecutive must have
at least local Administrator authority.

The PowerExecutive Setup program starts. After several seconds, the Welcome
window opens.

Click Next. The License Agreement window opens.

Read the license agreement, click I accept the terms in the license agreement,
and click Next. The Destination Folder window opens.

You can install to the folder specified or click Change to change to a different
destination folder. Once you decide which destination folder you want to use,
click Next. The IBM PowerExecutive 2.10 SA service account information
window opens.

The IBM PowerExecutive 2.10 SA service account is used to log onto the server

when IBM Embedded Director starts up. The IBM PowerExecutive 2.10 SA
service account window contains the following fields:

Local computer name or domain
Type the account with either local or domain Administrator privileges.

User name
Type the user ID for the account with either local or domain
Administrator privileges.
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Password
Type the password with either local or domain Administrator
privileges.

Confirm password
Retype the password with either local or domain Administrator
privileges.

Click Next. The Ready to Install the Program window opens.
Click Install.

When you are installing PowerExecutive Console or PowerExecutive Server
when IBM Director Server is not running, the Installing IBM PowerExecutive
window opens. The progress of the installation is displayed.

If this is an upgrade, and the existing PowerExecutive database is from a prior
release, then a warning prompt occurs that indicates that the previous version
of PowerExecutive will no longer be able to access the database once version
2.10 has been started.

Restriction: This statement is not applicable to the stand-alone version of
PowerExecutive. You should not use the stand-alone version as an
upgrade.

8. Click Finish.

Installing PowerExecutive on systems running Linux

This section provides instructions for installing PowerExecutive on systems that are
running Linux.

If you are installing PowerExecutive on systems that are running Windows, see

[“Installing PowerExecutive on systems running Windows” on page 15

To install PowerExecutive on a Linux system:

On systems where you are installing PowerExecutive Server, enter the following
command at the command prompt:

rpm -iv PowerExecutive-server-2.10-2.noarch.rpm

On systems where you are installing PowerExecutive Console, enter the
following command at the command prompt:

rpm -iv PowerExecutive-console-2.10-2.noarch.rpm

On systems where you are installing PowerExecutive stand-alone, enter the
following command at the command prompt:

rpm -iv PowerExecutiveSA-2.10-1.noarch.rpm

If you are installing PowerExecutive Server and IBM Director Server is running,
then this installation stops the IBM Director service before the PowerExecutive
installation begins. After the PowerExecutive installation is completed, the IBM
Director service is restarted.

Restriction: This statement is not applicable to the stand-alone version of

PowerExecutive. To use the stand-alone version, IBM Director should
not be installed on the machine.
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Uninstalling PowerExecutive on systems running Windows

Use these instructions for uninstalling PowerExecutive on systems that are running
Windows.

If you are uninstalling PowerExecutive on systems that are running Linux, see
[“Uninstalling PowerExecutive on systems running Linux.”|

Complete the following steps to uninstall PowerExecutive on systems that are
running Windows:

1. Click Start » Settings » Control Panel. The Control Panel window opens.

2. Double-click Add/Remove Programs. The Add/Remove Programs window
opens.

3. Click the currently installed program IBM PowerExecutive; then click
Change/Remove.

Attention: If you are uninstalling the stand-alone version of PowerExecutive,
you click Change.

4. Follow any further instructions on the window.

Uninstalling PowerExecutive on systems running Linux

18

Use these instructions for uninstalling PowerExecutive on systems that are running
Linux.

If you are uninstalling PowerExecutive from systems that are running Windows,
see [“Uninstalling PowerExecutive on systems running Windows.”|

To uninstall PowerExecutive from a Linux system:

* On systems where you are uninstalling PowerExecutive Server, enter the
following command at the command prompt:

rpm -ev PowerExecutive-server

* On systems where you are uninstalling PowerExecutive Console, enter the
following command at the command prompt:

rpm -ev PowerExecutive-console

* On systems where you are uninstalling PowerExecutive stand-alone, enter the
following command at the command prompt:

rpm -ev PowerExecutiveSA
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Chapter 3. Using PowerExecutive

You can use PowerExecutive, extension or stand-alone, to monitor and collect
power consumption data, manage trend data, set power capping targets and export
data.

Connecting to BladeCenter chassis and rack-mounted servers from
IBM Director

Follow these steps to connect to BladeCenter chassis and rack-mounted servers
from IBM Director.

Connecting to BladeCenter chassis from IBM Director
1. Go to the IBM Director Console and select menu items: Console » New -
Managed Objects » BladeCenter Chassis.

2. In the Add BladeCenter Chassis dialog, specify the Chassis Name, IP Address,
User ID, and Password. The IP address must be that of the management
module in the chassis.

3. Click OK.

Connecting to rack-mounted servers from IBM Director
1. Go to the IBM Director Console and select menu items: Console » New -
Managed Objects » Physical Platforms.

2. In the Add Physical Platforms dialog, specify the Name and Network Address.
The Network Address must be the IP address of the BMC in the rack-mounted
server.

3. Click OK.

Monitoring power-consumption data

Use PowerExecutive to display details and summaries about both power-managed
systems and unmanaged systems.

Each node in the navigation tree of PowerExecutive represents an object that is
being managed. There is one top-level node with two children:

* Power-Managed Systems consist of all currently targeted rack-mounted servers or
BladeCenter chassis that support power metering.

* Other Systems consist of all currently targeted rack-mounted servers that don’t
support power metering.

Restriction: All BladeCenter chassis are considered to be power-managed, so
chassis cannot appear in this group.

You can display the following details and summaries about power-managed
systems:

* For a group of BladeCenter chassis or rack-mounted servers, you can display
details and summary information.

* For an individual BladeCenter chassis, you can display details and summary
information.
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* For an individual rack-mounted server, you can display details.

* For an individual power domain in a BladeCenter chassis, you can display
details and summary information.

* For an individual module in a power domain, you can display details.

Remember: Keep in mind the following assumptions when viewing
power-consumption data:

1. If data is expected and is in fact available, the data appears in the
cell in question.

2. If data is not expected or applicable, the cell is left blank, to avoid
clutter.

3. If data is expected but has yet to arrive (for example, the console is
waiting for a response from the server), the cell contains ....

4. If data is expected but an error condition prevents its retrieval, the
cell contains the word Error.

5. If data for one or more rack servers or BladeCenter chassis in a
group of systems is not available, PowerExecutive cannot calculate
the correct power consumption for that group. As a result, a total
power value for that group is not displayed.

Understanding differences between PowerExecutive and
management module power displays

Power data for the BladeCenter Management Module or Advanced Management
Module may differ slightly from the data displayed by PowerExecutive.

The Web page for a BladeCenter Management Module or Advanced Management
Module displays power data for the power domains and the individual
components in the corresponding chassis. This data may differ slightly from that
displayed by PowerExecutive for the following reasons:

* Older versions of management module firmware may display only static
nameplate power values for blades while PowerExecutive displays dynamic
power values obtained from the built-in power meter.

* The management module firmware may report non-zero power values for empty
slots. For example, an empty I/O module slot may have a non-zero power
value. This value represents power that the management module is reserving for
that slot to guarantee that it can be powered on (if a module is plugged in).

PowerExecutive, on the other hand, reports the actual power consumed, not the
amount reserved. As a result, the actual amount will always be zero for an
empty slot.

* The management module and IBM Director display a multi-wide blade as a
single entity. This differs from PowerExecutive. PowerExecutive displays a blade
on a per-slot basis. Each slot occupied by a blade is reported in PowerExecutive.

Displaying details and summary information about a group of
BladeCenter chassis

You can display the details and summary information that PowerExecutive
provides about a group of BladeCenter chassis.

Complete the following steps to display details and summary information about a
group of BladeCenter chassis:
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1. From IBM Director Console, drag the PowerExecutive task onto a group of

chassis.

2. In the Navigation pane of the PowerExecutive Console, look at the information
in the Current® Data pane.

Each row in the table corresponds to one BladeCenter chassis in the group. All
power numbers in the table represent alternating current (ac) power.

The last row of the table summarizes information about the chassis in the group.

describes the information that is displayed for each chassis in the group.

Table 6. Detail and summary information about a group of BladeCenter chassis

Column title

Description

Name

The name of the BladeCenter chassis.

Data Collection

The status of data collection. Values are Enabled, Disabled and Offline.

The offline status is used when data collection is enabled, but the
management module is not responsive. The offline status reflects only
whether the management module is responsive to PowerExecutive. It
is not an indicator of system health.

Average Watts (ac)

The sum of the power in use by all power domains in the BladeCenter
chassis. This value is measured in watts.

°C Ambient The current ambient (inlet) temperature of the chassis. This value is
measured in Celsius degrees.

°C Exhaust The current temperature of the air exiting the box. This value is
measured in Celsius degrees and is available only for BC-2 chassis.
The column remains blank if data is not available.

BTUs/hr An estimate, based on the power in use, of the thermal load in British

thermal units (BTU) placed on the surrounding environment by this
chassis.

The following formula is used to determine the estimate that is
displayed:
1 watt = 3.412 BTUs/hour

Acoustic Mode

Indicates whether acoustic mode is in use for the BladeCenter chassis.
Values are Enabled or Disabled. This column defaults to a position
right of the BTUs/hr column. For information about acoustic mode,
see the documentation that comes with the management module that
is in the affected chassis.

Time

The time at which the current data was collected.

Summary Row

Totals for the following columns:
* Watts in Use

* Nameplate Watts

* BTU/hr

Displaying details and summary information about an
individual BladeCenter chassis

You can display the details and summary information that PowerExecutive
provides about an individual BladeCenter chassis.
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Complete the following steps to display details and summary information about an
individual BladeCenter chassis:

1. From IBM Director Console, drag the PowerExecutive task onto a chassis.

2. In the Navigation pane of the PowerExecutive Console, look at the information
in the Current Data pane.

Each row in the table corresponds to one power domain in the chassis. All power
numbers in the table represent ac power.

The last row of the table summarizes information about the power objects in the
BladeCenter chassis as a whole.

describes the information that is displayed for each row in the table.

Table 7. Detail and summary information about an individual chassis

Column title

Description

Name

The name of the power domain to which the row in question
corresponds, for example Power Domain 1.

Average Watts
(ac)

The sum of the Average Watts (ac) of all modules in the power domain,
or -- if power data is not available.

°C Ambient

The current ambient (inlet) temperature of the chassis. This value is
measured in Celsius degrees.

°C Exhaust

The current exhaust (outlet) temperature of the chassis. This value is
measured in Celsius degrees and is available only for BC-2 chassis. The
column remains blank if data is not available.

Redundancy
Status

The redundancy in the power domain. The following values are
available:

¢ Redundant Power Available

* Non-Redundant Power Available

* No Power Available

For information about power-management policy settings, including
redundancy in the power domain, see the documentation that comes
with the MM that is in the affected BladeCenter chassis.

Oversubscription
Policy

The oversubscription policy that the BladeCenter chassis is using. Values
are one of the following:

* Redundant without Performance Impact

* Redundant with Performance Impact

* Non-Redundant

These correspond, respectively, to the following:
* No Over-Subscription (NOS)

* Recoverable Over-Subscription (ROS)

* Non-Recoverable Over-Subscription (NROS)

For information about oversubscription policies, see the documentation
that comes with the MM that is in the affected BladeCenter chassis.

Time

The time at which the current data was collected.

Displaying details and summary information about individual
power domains

You can display the details and summary information that PowerExecutive
provides about an individual power domain within a BladeCenter chassis.
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Complete the following steps to display details and summary information about an
individual power domain:

1. From IBM Director Console, drag the PowerExecutive task onto the
BladeCenter chassis that contains the power domain.

2. In the Navigation pane of the PowerExecutive Console, expand the tree
structure until you see the power domain.

3. Click the name of the power domain and look at the information in the Current

Data pane.

Each row in the table corresponds to one bay, which is generally one module,
within the power domain. The power numbers for modules in the table represent

dc power.

The last row of the table summarizes information about the power domain as a
whole. The power numbers in the summary row represent ac power.

describes the information that is displayed for each row in the table.

Table 8. Detail information about modules in a power domain

Column title |Description

Name If the slot is populated, the name of the module in the slot to which the
row in question corresponds, for example, IBM 8832L1X KPZH797. If
information is not available, the value is--.

Type The slot type as reported by VPD.

Bay The number of the bays that this module occupies.

Power Meter

The version of the power meter in the blade, or None for legacy blades or
non-blade modules.

Metering
Level

The metering level of the power meter (if it is present). It can be one of the
following values:

* Disabled

* Monitoring only

* Capping

* -- (if no value is available)

Power Savings
Supported by
Platform

The power savings status for the module. It can be one of the following
values:

* Yes
* No
This reflects only BIOS enablement of power savings (for example, DBS on

Intel or PowerNow on AMD). The operating system might not enable
power savings even if the BIOS has enabled it.

Average Watts
(de)

For a power meter-enabled blade server, the power currently being
consumed as reported by the power meter, or -- if power data is not
available. For all other blade servers and modules, the same as the
Nameplate Watts (dc) value, possibly derated by a factor specified by the
user.

Pcap (dc)

The current power cap.

Effective CPU
Speed (%)

The effective CPU speed as a percentage.

Time

The time at which the current data was collected.
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Displaying details about individual modules

You can display the details that PowerExecutive provides about individual

modules.

Complete the following steps to display details about an individual module:

1. From IBM Director Console, drag the PowerExecutive task onto the chassis
object that contains the module.

2. In the Navigation pane of the PowerExecutive Console window, expand the
tree structure until you see the module.

3. Click the name of the module and look at the information in the Current Data

pane.

Each row in the table corresponds to one module in the chassis.

You can display information about the following module types:

¢ Power-managed blade server modules

* Legacy (non-power-metered) blade server modules

e Other non-blade-server modules

describes the information that is displayed for an individual
power-managed blade server module.

Table 9. Detail information about a power-managed blade server module

Field name

Description

Name

The name of the module. No value is displayed when the bay is
not populated.

Type

The type of module. The following values are available:

* Power Module
Tip: The power consumption listed for the power module
represents the amount of power lost in the power module.

* Blade Server

* 1/0O Module

* Management Module

* Blower Module

* Media Tray

* Midplane

Bay

The number of the bay that this module occupies.

Power Meter

Displays the version number of the power meter.

Metering Level

The metering level for the module. It can be one of the following
values:

* Monitoring Only

* Capping
* None

Power Savings
Supported by Platform

The power savings status for the module. It can be one of the
following values:

* Yes
* No
This reflects only BIOS enablement of power savings (for example,

DBS on Intel or PowerNow on AMD). The operating system might
not enable power savings even if the BIOS has enabled it.

Nameplate Watts (dc)

The nameplate power as reported by VPD.
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Table 9. Detail information about a power-managed blade server module (continued)

Field name

Description

Average Watts (dc)

The power in use of the module.

Pcap (dc)

The current power cap.

Pcap Max (dc)

The maximum possible power cap for this module.

Pcap Min (dc)

The minimum possible power cap for this module.

Effective CPU Speed
(%)

The effective CPU speed as a percentage.

Last Policy

The last policy for this module.

able 10| describes the information that is displayed for an individual
power-managed blade server module. The power numbers in the table represent

dc power.

Table 10. Detail information about a legacy (non-power-metered) blade server module

Field name

Description

Time The time at which the current data was collected.

Name The name of the module. No value is displayed when the bay is
not populated.

Type The type of module.

Bay The number of the bay that this module occupies.

Power Meter

Displays the version number of the power meter. However,
displays None for non-power-metered blade servers.

Derate Nameplate
Watts to (%)

User-specified derating factor that you apply to the label power
for the module in question to estimate the power in use. The
maximum (and default) is 100%, meaning that no derating is
performed. The minimum is 0%, meaning that the label power is
to be derated entirely, giving an estimate of zero power in use.

Nameplate Watts (dc)

The nameplate power as reported by VPD.

Average Watts (dc)

The power in use of the module.

Current CPU Throttle
Values (%)

(Blade server only) A comma-separated list of the current throttle
values of each processor in the blade server. A value of 100%
indicates that a processor is running at maximum performance
(full throttle). For information about throttle levels, see the
documentation that comes with the BladeCenter management
module that is in the affected chassis.

Preset Blade Throttle
Value (W)

(Blade server only) The preset throttle level of the BladeCenter
chassis that contains this module. For information about throttle
levels, see the documentation that comes with the BladeCenter
MM that is in the affected chassis.

able 11| describes the information that is displayed for an individual
power-managed blade server module. The power numbers in the table represent

dc power.

Table 11. Detail information about other non-blade server modules

Field name

Description

Time

The time at which the current data was collected.
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Table 11. Detail information about other non-blade server modules (continued)

Field name

Description

Name

The name of the module. No value is displayed when the bay is
not populated.

Type

The type of module. The following values are available:

¢ Power Module
Tip: The power consumption listed for the power module
represents the amount of power lost in the power module.

* 1/O Module

¢ Management Module

* Blower Module

* Media Tray

* Midplane

Bay

The number of the bay that this module occupies.

Power Meter

Displays the version number of the power meter. However,
displays None for all non-blade server modules.

Derate Nameplate
Watts to (%)

User-specified derating factor that you apply to the label power
for the module in question to estimate the power in use. The
maximum (and default) is 100%, meaning that no derating is
performed. The minimum is 0%, meaning that the label power is
to be derated entirely, giving an estimate of zero power in use.

Nameplate Watts (dc)

The nameplate power as reported by VPD.

Average Watts (dc)

The power in use of the module.

Displaying details about power-managed rack-mounted
servers

You can display the details that PowerExecutive provides about power-managed

rack-mounted servers.

Complete the following steps to display details about a power-managed

rack-mounted server:

1. From IBM Director Console, drag the PowerExecutive task onto the managed
system representing the server.

2. In the Navigation pane of the PowerExecutive window, expand the tree
structure until you see the server.

3. Click the name of the server, and look at the information in the Current Data

pane.

Each row in the table corresponds to one data item describing the rack-mounted

server.

Table 12. Detail information about a power managed rack-mounted server

Field name Description
Time The time at which the current data was collected.
Name The name of the rack-mounted server.

Power Meter

The version of the power meter if the rack-mounted server is
power-managed, otherwise the value is None.
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Table 12. Detail information about a power managed rack-mounted server (continued)

Field name

Description

Metering Level

The metering level of the power meter (if it is present). It can be
one of the following values:

 Disabled

* Monitoring only

» Capping

e -- (if no value is available)

Power Savings
Supported by Platform

The power savings status for the server. It can be one of the
following values:

* Yes
* No
This reflects only BIOS enablement of power savings (for example,

DBS on Intel or PowerNow on AMD). The operating system might
not enable power savings even if the BIOS has enabled it.

Nameplate Watts (ac)

The maximum AC draw of the server, as reported by Power
Engineering.

Average Watts (ac)

The AC power currently being consumed as reported by the
power meter, or -- if power data is not available.

Average Watts (dc)

The DC power currently being consumed as reported by the
power meter, or -- if power data is not available

Pcap (dc)

The current power cap.

Pcap_max (dc)

The maximum possible power cap for this rack-mounted server.

Pcap_min (dc)

The minimum possible power cap for this rack-mounted server.

°C Ambient The current ambient (inlet) temperature of the rack-mounted
server.
°C Exhaust The current exhaust (outlet) temperature of the rack-mounted

server. This value is measured in Celsius degrees and is an
estimate based on the current ambient temperature and fan RPM
of the rack-mounted server. It is not a direct measurement.

Effective CPU Speed
(%)

The effective CPU speed as a percentage.

Last policy

The last policy of this rack-mounted server.

Displaying details about unmanaged rack-mounted servers

You can display the details that PowerExecutive provides about unmanaged

rack-mounted servers.

Complete the following steps to display details about an unmanaged rack-mounted

server:

1. From IBM Director Console, drag the PowerExecutive task onto the object that
contains the server.

2. In the Navigation pane of the PowerExecutive window, click Other Systems to
expand the tree structure until you see the server.

3. Click the name of the server and look at the information in the Current Data

pane.
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Each row in the table corresponds to an unmanaged rack-mounted server.

Table 13. Detail information about an unmanaged rack-mounted server

Field name Description

Name The name of the rack-mounted server

Power Meter The version of the power meter if the rack-mounted server is
power-managed, otherwise the value is None.

Metering Level Disabled for a power-managed rack server, else N/A.

Upgradeable Yes if the server could become power-managed with a firmware

upgrade; No if not

Setting the power cap value

You can set the power cap value for rack or blade servers.

The power cap (Pcap) value, specified in watts, is the value to which a given rack
or blade server will be capped by the PowerExecutive firmware (when the
firmware supports capping). The power cap value is persistent across power cycles
for both rack and blade servers.

Note: If a blade is removed from a chassis, then the power cap setting is lost.

Average power consumption on a blade may or may not reach or exceed the
minimum power capping threshold. The minimum power capping threshold
represents a value that can be guaranteed under all operating conditions.
PowerExecutive will not actively limit, or cap, the power consumption for a blade
when the average power consumption is below the minimum power capping
threshold (Pcap_min). No power capping will occur when the average power
consumption is below the minimum power capping threshold. It is common for a
blade to consume less power than the minimum power capping threshold. Total
power consumption on a blade is related to certain conditions that can include
hardware configuration of the blade and applications executing on the blade.

Complete these steps to set the power cap value:
1. From IBM Director Console, start PowerExecutive.

2. From the PowerExecutive window, click Edit ®* Manage Power or click the
Manage Power icon on the Tool bar. The PowerExecutive Create or edit power
policy window opens.

3. From the PowerExecutive Create or edit power policy window, specify the new
policy in one of three ways: Percentage of power limit range, Power limit
range, or Compute power limit based on historical data.

a. Percentage of power limit range: Choose this option to specify a cap in
terms of a percentage between the Pcap_min and Pcap_max value
ranges.Specifying a cap in this way is particularly useful when there is a
group of unlike systems where a specific Pcap value is not appropriate, but
where a capping percentage makes sense. The percentage can be set using
either the slider or the text box. A percentage of 0% means that the Pcap
value is set to the minimum valid value (for example, Pcap_min), in which
case the system throttle value is set to the maximum extent possible. A
percentage of 100% means that the Pcap value is set to the maximum valid
value (for example, Pcap_max), in which case throttling never occurs. A
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percentage between 0% and 100% means that the Pcap value is set to a
value corresponding to a distance between the Pcap_min and Pcap_max
value ranges.

Restriction: A percentage of 0% does not necessarily mean that the system
will always be throttled to the maximum extent. It just means
that the maximum amount of throttling is possible at this
setting.

b. Power limit range: Choose this option for a single system, or for a group of
similar systems for which the same Pcap value is appropriate. You can
specify a Pcap value either by adjusting the slider or by entering the desired
value directly in the text box. If you click Apply, a window displays in
which you can specify the systems to which the Pcap value should be
applied. The new value takes effect immediately. The new window also
gives you the option to Save as Task. If you click Save as Task, another
window displays allowing you to specify a name for the task. A task is then
created in the Tasks pane of Director Console (if the task already exists, it is
updated using the currently specified parameters). The task can then be run
from Director Console.

c. Compute power limit based on historical data:Choose this option to
specify a historical period to examine, using the drop-down list box, and a
power-limiting goal, using the slider. A power-limiting goal of 0%
corresponds to a Pcap value equal to the maximum-observed power over
the period of interest. A negative percentage corresponds to a Pcap value
lower than the observed maximum, and a positive percentage corresponds
to a Pcap value greater than the observed maximum (allowing room for the
power consumption to grow without incurring throttling).

Setting the derating power factor

You can set the derating power factor for an individual module that is not power
meter enabled in a chassis. By default, the derating power factor is 100%, which
means that the reported power is not derated at all.

The derating factor is the percentage of the static maximum power that is used
when estimating the power in use for blade servers that are not power meter
enabled and for all other modules. The derating factor does not apply to blade
servers that are power meter enabled.

Complete these steps to set the derating factor:
1. From IBM Director Console, start PowerExecutive.

2. In the Navigation pane, select the module that you want to derate. You cannot
derate power for a chassis or a power domain, you must select a module.

3. From the PowerExecutive window, click Edit ® Derate Power. The
PowerExecutive Derate Power Factor window opens.

4. From the PowerExecutive Derate Power Factor window, enter a number that
represents the percent of the static maximum power that you want to use when
estimating the power consumption of the module.

5. Click OK.

Collecting power consumption data

By default, power information is collected for all BladeCenter chassis or
rack-mounted servers or both that are displayed in PowerExecutive.
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Suspending data collection

You can suspend data collection on any chassis or server displayed in
PowerExecutive.

You might decide to suspend data collection to decrease the amount of disk space
required in the PowerExecutive database. Another reason might be to reduce the
network load from polling for new information.

You cannot suspend Data collection for individual modules within a chassis.

Complete these steps to suspend data collection for a chassis or a server:
1. From IBM Director Console, start PowerExecutive.

2. In the Navigation pane of the Power Executive Console, select the chassis or
server for which you want to suspend data collection.

3. From the PowerExecutive Console, click Edit » Enable Data Collection to
remove the check mark next to Enable Data Collection.

Data collection is suspended.

Resuming data collection

You can resume data collection for a chassis or server displayed in PowerExecutive
in which data collection was previously suspended.

Resuming data collection increases the amount of disk space required in the
PowerExecutive database. It also increases the network load as it polls for new
information.

Complete these steps to resume data collection for a chassis:
1. From IBM Director Console, start PowerExecutive.

2. In the Navigation pane of the PowerExecutive Console, select the chassis or
server for which you want to resume data collection.

3. From the PowerExecutive Console, click Edit » Enable Data Collection to add
a check mark next to Enable Data Collection.

Data collection is resumed.

Managing trend data

30

This section provides information about using PowerExecutive to manage trend
data.

Trend data is displayed in the Trend Data pane of the PowerExecutive console. For
more information, see [“Trend Data pane” on page 7|

Managing collection of trend data

You can manage trend data using the Edit menu of PowerExecutive.

Historical trend data is written to the PowerExecutive database. You can control
how often and how much historical trend data is written to the database and when
trend data is deleted.

However, when the PowerExecutive database cannot expand, it deletes the oldest
historical data from the database to free up room for new data that it is collecting.
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Complete these steps to affect the trend data written to the PowerExecutive
database:

1.
2.

4.

From IBM Director Console, start PowerExecutive.

From the Power Executive Console, click Edit * Manage Trend Data. The
Manage Trend Data window opens.

Complete the fields on the Manage Trend Data window as follows:

* In the Short-term data collection in minutes field, enter the number of
minutes in the short-term data-collection cycle. The default value is one
minute. In addition, the value is limited by the interval in which you can
poll the system.

Once every short-term data-collection interval, PowerExecutive collects
temperature and power data from the systems under its control. The data
collected during these cycles is considered to be short-term data collection.
Lower values in this field could have an impact on the network performance
of the systems involved.

¢ In the Long-term data collection in minutes field, enter the number of
minutes in the long-term data collection cycle. The default value is ten
minutes. PowerExecutive uses the long-term data collection cycle to
determine which data is considered to be long-term data. Long-term data is
the trend data that you can display on the Trend Data pane.

Important: All short-term data points that fall within the Long-term data
collection in minutes time period are coalesced into a single
long-term data record.

* In the Number of days to keep short-term trend data field, enter the
number of days that PowerExecutive identifies data as short-term data before
considering it to be long-term data. The default value is 31 days.

* In the Number of days to keep long-term trend data field, enter the number
of days that PowerExecutive keeps long-term data before deleting it. The
default value is 365 days.

Click Apply to save the settings, recompute and then display the data at the
bottom of the dialog box so you don’t have to re-open the dialog to see how
the new settings affect the projected size of the PowerExecutive database. Click
OK to save the settings, and dismiss the dialog box.

Creating a custom time interval for the Trend Data pane

You can create a custom time interval for use by the Trend Data pane instead of
using one of the predefined time intervals.

Complete the following steps to create a custom time interval for the Trend Data
pane:

1.
2.

From IBM Director Console, start PowerExecutive.

From the Trend Data pane in the PowerExecutive window, click the drop-down
box in the upper left corner.

Click Add/Change custom interval as the trend data interval. The

PowerExecutive Custom window opens.

Complete the fields on the PowerExecutive Custom window in the following

way:

* In the first row of fields, enter the day and time from which the trend data
should start. Define the month, day, year, hour, and minute from which to
start displaying trend data.
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* In the second row of fields, enter the day and time at which the trend data
should stop. Define the month, day, year, hour, and minute at which to stop
displaying trend data.

5. Click OK.

Exporting data from PowerExecutive

Use this section to get information about exporting data from PowerExecutive.

You can export the following types of data:
e Current data from the Current Data pane
* Trend data chart from the Trend Data pane
e Trend data table from the Trend Data pane

Exporting current data

Use the File menu in PowerExecutive to export current data from the Current Data
pane.

PowerExecutive can save the exported current data in comma-separated value
(CSV), XML or HTML format.

Complete the following steps to export the current data in the Current Data pane:
1. From IBM Director Console, start PowerExecutive.

2. From the PowerExecutive Console, click File » Export »+ Current Data. The
Export Current Data window opens.

Select the directory where you want to export the data.

In the File Name field, type a name for the file.

In the Files of Type field, select the type of file that you want to create.
Click OK.

ook w

Exporting a Trend Data chart

To export the Trend Data chart, the chart must be displayed in the PowerExecutive
Console.

PowerExecutive saves the exported Trend Data chart in JPEG format.

Complete the following steps to export the Trend Data chart:
1. From IBM Director Console, start PowerExecutive.

2. From the PowerExecutive Console, click File » Export » Trend Data as Chart.
The Export Trend Data as Chart window opens.

3. Select the directory where you want to export the data.
4. In the File Name field, type a name for the file.
5. Click OK.

Exporting a Trend Data table

To export the Trend Data table, the table must be displayed in the PowerExecutive
Console.

Power Executive can save the exported Trend Data table in CSV, XML or HTML
format.
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Complete the following steps to export a Trend Data table:
1. From IBM Director Console, start PowerExecutive.

2. From the PowerExecutive Console, click File + Export » Trend Data as Table.
The Export Trend Data as Table window opens.

Select the directory where you want to export the data.

In the File Name field, type a name for the file.

In the Files of Type field, select the type of file that you want to create.
Click OK.

ook w

Events that affect PowerExecutive

You should understand the IBM Director events and PowerExecutive events that
affect the information that is displayed in PowerExecutive. Events can be external
(generated by IBM Director) or internal (generated by PowerExecutive).

Before using PowerExecutive, use the Management Processor Configuration
subtask of the Server Configuration Manager task (formerly Management Processor
Assistant [MPA]) to configure an alert-forwarding profile for the chassis that you
plan to monitor. In the alert-forwarding profile, set the connection type to IBM
Director Comprehensive and set the IP address to the IP address of the
management server that is being used to monitor power consumption with
PowerExecutive.

Important: This management server must be the only server that is configured and
enabled to receive alerts from the chassis that you plan to target.

If you do not create an alert-forwarding profile for a chassis, PowerExecutive
cannot receive any events for that chassis.

The IBM Director event log might not contain all events that are reported in
PowerExecutive. Further, the timestamp on events is different between the IBM
Director event log and the trend pane in Power Executive. The IBM Director event
log records the time that the defect occurred. The PowerExecutive events reflect the
time that PowerExecutive detected the event.

External events

Some events from Server Configuration Manager cause PowerExecutive to poll for
new information and refresh the PowerExecutive Console as needed. Server
Configuration Manager is an IBM Director task that is used to create or update
server configuration profiles, which include management of service processors in
System x* and IBM Netfinity® servers.

External events are generated by the MM in a BladeCenter chassis, intercepted by
IBM Director, and communicated up to PowerExecutive through the IBM Director
event-subscription mechanism.

describes the severities that can be assigned to each event.

Table 14. Event severities and their meanings

Event
severity | Description

Critical Severe events that signal that the system might not be functioning.

Warning | Serious events that could progress to critical severity.
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Table 14. Event severities and their meanings (continued)

Event
severity

Description

Harmless

Any event that is not severe or serious. These events are not necessarily errors.

able 15| describes the events that can cause the information to be refreshed in the
PowerExecutive Console.

Table 15. Events that affect the information in PowerExecutive

Severity

Category

Description

Critical

Power failure

A system power supply failed.

Critical

Chassis failed

There are no working fans in the chassis.

Critical

Power supply failed

A power supply is now functioning properly in the
chassis.

Warning

Blade power off

The server is powering off.

Warning

Management
Module active

A management module assumed control of the chassis.

Warning

Mismatched power
supplies

The power supplies are mismatched.

Warning

Power redundancy
lost

Power redundancy was lost in the chassis.

Warning

1/0O module
redundancy lost

The I/O module redundancy was lost in the chassis.

Warning

I/0 module power
off

An I/0 module in the chassis was powered off.

Harmless

I/0O module power
on

An I/0O module in the chassis was powered on.

Harmless

I/0O module
redundancy restored

The I/O module redundancy was restored in the chassis.

Harmless

No mismatched
power supplies

No mismatched power supplies were detected in the
chassis.

Harmless

Blade throttled

A blade server in the chassis is throttled in order to
maintain a power consumption within certain bounds. A
recovery event is also sent.

Harmless

Blade unthrottled

A blade server in the chassis is no longer throttled.

Harmless

Blade power on

The server is powering on.

Harmless

Service processor
test

The service processor sent a test event.

Harmless

Power redundancy
restored

Power redundancy was restored in the chassis.

Harmless

Power supply
recovered

The power supply was recovered.

Internal events
PowerExecutive displays information about events that it generates in the Trend

Data pane.

34

IBM PowerExecutive Installation and User's Guide




Internal events are generated internally by PowerExecutive itself, rather than an
MM, but tracked by PowerExecutive and displayed to the user by the same
mechanism as MM-generated events.

Specifically, PowerExecutive generates and displays internal event information

with the following severities.

Table 16. Event severities and their meanings

Event

severity | Description

Critical Severe events that signal that the system might not be functioning.

Warning | Serious events that could progress to critical severity.

Harmless | Any event that is not severe or serious. These events are not necessarily errors.

describes the internal events that can cause the information to be refreshed
in the PowerExecutive Console.

Important: The term server in the descriptions below can be a placeholder for a
rack-mounted server, chassis, or module type.

Table 17. Internal events that affect the information in PowerExecutive

Severity | Category Description

Critical Server power A power supply was removed from the server.
supply removed

Critical BMC HW error A BMC power meter hardware calibration error has
calibration occurred on the server.

Warning | PowerExecutive PowerExecutive was stopped.
stopped

Warning | Chassis removed The chassis was removed.

Warning | Data collected Data collection was suspended for the chassis.
suspended

Warning | Chassis offline The chassis is offline.

Warning | Module removed A module was removed from the chassis.

Warning | Long-term data Long-term data was discarded.
discarded

Warning | Time change Time change detected; data may not be accurate.
detected

Warning | Server power off The rack-mounted server is powering off.

Warning | Server removed The rack-mounted server was removed.

Warning | Server offline The rack-mounted server is offline.

Warning | Server not The rack-mounted server is no longer power-managed.
power-managed

Warning | Server inventory not | Server power inventory is not complete for the server.
compete

Warning | Firmware The BMC firmware was downgraded for the server.
downgraded

Warning | Firmware The BMC firmware for the server is not supported.
unsupported

Chapter 3. Using PowerExecutive 35



36

Table 17. Internal events that affect the information in PowerExecutive (continued)

Severity | Category Description
Warning | Write access Host Write access to power management registers on the
detected server was detected.
Warning | Pcap min changed | The minimum power cap value for the server was
updated.
Warning | Pcap max changed | The maximum power cap value for the server was
updated.
Warning | Pcap less than Pcap |The new minimum power cap value for the server
min exceeded the power cap value.
Warning | Power capping Power capping was disabled for the server.
removed
Warning | Power measurement | Power measurement was disabled for the server.
removed
Warning | Power interval The BMC polling interval for the server is greater than
greater the app polling interval.
Warning | Power interval less | The BMC polling interval for the server is less than the
app polling interval.
Warning | BMC HW error A BMC exhaust temperature sensor failure has occurred
exhaust temp on the server.
Warning | BMC HW error inlet | A BMC inlet temperature sensor failure has occurred on
temp the server.
Warning | BMC reset detected | A BMC reset was detected on the server.
Warning | Database warning | The projected database size exceeded the space available
on the volume.
Harmless |PowerExecutive PowerExecutive was started.
started
Harmless |Chassis added The chassis was added.
Harmless |Data collection Data collection was resumed for the chassis
resumed
Harmless | Chassis online The chassis is online.
Harmless | Acoustic mode Acoustic mode was enabled for the chassis.
enabled
Harmless | Acoustic mode Acoustic mode was disabled for the chassis.
disabled
Harmless | Oversubscription Power policy for the domain was changed to NOS (no
policy NOS oversubscription).
Harmless | Oversubscription Power policy for the domain was changed to ROS
policy ROS (recoverable oversubscription).
Harmless | Oversubscription Power policy for the domain was changed to NROS
policy NROS (non-recoverable oversubscription).
Harmless |Module inserted A module was inserted into the chassis.
Harmless |Short-term data Short-term data was coalesced.
coalesced
Harmless |Server power on The rack-mounted server is powering on.
Harmless |Server added The rack-mounted server was added.
Harmless |Server online The rack-mounted server is online.
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Table 17. Internal events that affect the information in PowerExecutive (continued)

Severity

Category

Description

Harmless

Server power
managed

The rack-mounted server is now power-managed.

Harmless

Server power save
mode change

The server entered or exited a power savings mode.

Harmless

Server rebooted

The BIOS for the server reported a system reboot.

Harmless

Server inventory
complete

Server Power Inventory has completed for the server.

Harmless

Server power
supply added

A power supply was added to the server.

Harmless

Firmware upgraded

The BMC firmware was upgraded to the server.

Harmless

Above car threshold

Average effective clock rate for the server is more than
80% of normal.

Harmless

Pcap changed

The power cap value for the server was altered.

Harmless

Power capping
added

Power capping was enabled for the server.

Harmless

Power measurement
added

Power measurement was enabled for the server.

Harmless

PS label power
changed

A change was detected in the Label Power for the server.

Harmless

BMC HW ERRCLR
exhaust temp

A BMC exhaust temperature sensor error has been
cleared on the server.

Harmless

BMC HW ERRCLR
inlet temp

A BMC inlet temperature sensor has been cleared on the
server.

Harmless

Database resolved

The projected database size no longer exceeds the space
available on the volume.

Events that PowerExecutive generates are collected with other trend data and
stored in the PowerExecutive database. These events let you know why historical
data might be missing for one or more chassis.

In the Trend Data chart, these events are displayed:

* Events with a critical severity are shown as red squares.

* Events with a warning severity are shown as yellow diamonds.

* Events with a harmless severity are shown as green triangles.

You can place your mouse over each event in the Trend Data chart to obtain a
description of the event that occurred.

In the Trend Data table, these events are displayed in the Event column.

Using the Watt-Hour Meter

The Watt-Hour Meter allows you to display the amount of power used for a given
system or group of systems over a specified period of time and calculates the
corresponding cost of that power.
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The Watt-Hour Meter gives a visual indication of the number of watt-hours
consumed by the target object or objects over the specified time period. This is
compared to what would have been consumed had nameplate power been drawn
over that entire period.

To use the Watt-Hour Meter:
1. From the menu bar, select Edit » Watt-Hour Meter....

Note: You can also select the Edit Watt-Hour Meter icon in the toolbar.

Table 18. Detail information about the Watt-Hour Meter

Field name

Description

Target

The system or group of systems for which power is calculated.

Time Period

The time period for which power is calculated for the specified
system or group of systems. This is the time period that is defined
in the trend chart or table.

Enter price per
kilowatt-hour

Specify the cost of power per kilowatt-hour. The monetary unit for
the default locale is used. No monetary unit needs to be specified
here.

Note: This value is saved across PowerExecutive Console sessions.

Enter cooling rate
factor

Specify how much cooling contributes to the cost of the power
consumption currently being displayed. The default is 1.5. This
means that every dollar (or your local currency) spent on power
requires that an additional 1.5 dollars be spent on cooling to offset
the heat generated by that power. To estimate the cost of power
alone, this factor can be set to 0.

Note: This value is saved across PowerExecutive Console sessions.

Cost of actual power

The estimated cost of the power actually consumed, based on the
price per kilowatt-hour.

Cost of nameplate
power

The estimated cost of the power that would have been consumed
had nameplate power been drawn through the specified interval.
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Chapter 4. Troubleshooting

IBM provides several options to troubleshoot and resolve problems with
PowerExecutive.

Known limitations, problems, and workarounds

This section contains information about IBM PowerExecutive 2.10 limitations,
problems and workarounds.

Limitations

¢ The Min/Max power readings shown in the user interface are representative of
measurements made within the rack-mounted server. Some external AC power
meters may not be able to capture or display the same peaks as are displayed
using the PowerExecutive power meter due to differences such as the averaging
periods of the PowerExecutive power meter, the averaging periods of the
external power meter, and the filtering behavior of your power supply.

¢ On Windows, saving exported data to a network share that is not mapped to a
drive letter is not supported. When using the File » Export function, you must
specify a local disk or a network share that is mapped to a drive when saving
the exported data.

¢ Demand Based Switching does not work on BladeCenter HS20 (machine type
8843).

* Power information on BladeCenter systems is refreshed at a default rate of once
every 10 minutes. Power values for blades in such a system will therefore not be
updated more frequently than every 10 minutes, regardless of the rate at which
PowerExecutive short-term polling is set to (once a minute, by default).

* The Advanced Management Module (AMM) displays information on allocated
power and the power capping range for an individual blade. The allocated
maximum power is not the worst case maximum amount of power that a blade
will utilize but is a typical maximum power across various configurations. This
maximum allocated power is used by the AMM to budget for a given blade a
typical maximum power in order to determine if a given blade will fit within
the domain’s power budget and be allowed to power on. The maximum power
in the power capping range will be different than the allocated maximum power.
The maximum power in the power capping range reflects the nameplate power
for the blade.

Known problems and workarounds

e Installation of PowerExecutive on Windows Server 2003 with SP1 and Windows
Server 2003 x64 Edition may fail if all Windows Installer hotfixes are not
installed.

— Workaround: To correct this problem, download and install MS KB 898715 to
upgrade the installer to version 3.1 v2. You can then install PowerExecutive.

* PowerExecutive displays a popup that says The following device is not
supported by PowerExecutive: <system name> on a system known to support
PowerExecutive.

— Workaround: The system may have an advanced management module
(Service Processor [SP]), which has its own Ethernet port, and, therefore, its
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own IP address. Director will talk to this SP. But, this SP does not have
PowerExecutive support. Only the on-board Base Management Controller
(BMC) has PowerExecutive support. The BMC is on the system board and it
shares the Ethernet port with the system. For PowerExecutive to display the
system, you must configure the BMC from the F1 BIOS Setup screen.

* PowerExecutive doesn’t display any systems even though the system that has

PowerExecutive installed supports PowerExecutive.

— Workaround: PowerExecutive only communicates out of band through the
network to the management processor on the system. Even though you have
one Ethernet cable into the system on the Ethernet 1 port, you will have two
IP addresses: one for the on board BMC and one for the OS. For
PowerExecutive to display the system on which it is installed, you must add
the BMC address to Director as a Physical Platform.

PowerExecutive tasks appear in the IBM Director console, but they do not
execute when clicked. This occurs when a system has IBM Director console
installed, but does not have PowerExecutive Console installed.

— Workaround: PowerExecutive Console and IBM Director console must both be
installed in order to be able to complete PowerExecutive tasks through the
Director console.

During installation, the following message is displayed:

1603: Error installing Windows Installer engine. A file which needs to be
replaced may be held in use. Close all applications and try again.

— Workaround: Click OK and continue the installation. If this does not solve the
problem, one or more of the following fixes may resolve the error:

1. Insufficient disk space
Increase your hard disk space.
2. Temp directory is not clean
Clean the Temp directory.
3. A certain file on the machine is locked

Close all applications running in the background. Reboot your computer.
Run the installation again.

4. Use Microsoft’'s Windows Installer Cleanup utility to remove traces of
previous installations.
This utility does not remove files installed by the installation, which may
need to be removed manually. For more information, refer to Microsoft’s
Knowledge Base.

The HS21 and HS41 blade servers have a known limitation in their power meter
hardware. The maximum value that the power meter circuit can measure, called
Full Scale Power (FSP), can be exceeded on fully configured servers when
running high performance computing applications. Under such operating
conditions, the measured power displayed by the PowerExecutive Application
GUI will remain saturated at FSP and will not reflect the actual power drawn by
the blade. Additionally, setting the power capping limit to a value higher than
FSP may lead to a failure in capping server power, under such operating
conditions. The maximum value of the power capping limit is based on
nameplate power of the blade server and is higher than the FSP.
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— Workaround: Do not set power capping limit above FSP. The FSP value is 388
W (246 W for blade hardware Rev 4). Throttling may occur when capping the
system at FSP in this case. If throttling is not desired, do not enable power
capping for this configuration.

* On Windows, saving exported data to a network share may sometimes fail with
an error stating that the file already exists even though it may have been deleted
on the actual share.

— Workaround: To correct this problem, use a different filename to export data
or reboot the machine to clean the network file cache information.

* On HS20 server blades, there is a known limitation on setting power capping at
or close to minimum power capping value on fully configured servers when
running high performance computing applications. A failure in power capping
may occur when power capping value is within 20W of the minimum power
capping value.

— Workaround: Do not set power capping limit within 20W of the minimum
power capping value in these configurations.

* On Linux, attempting to upgrade from IBM Director 5.10.3 to IBM Director
5.20.x fails when PowerExecutive 2.00 or PowerExecutive 2.00.1 is installed on
the system.

— Workaround: To upgrade IBM Director 5.10.3 to IBM Director 5.20.x when
PowerExecutive is already installed on the system:

1. Uninstall IBM PowerExecutive using the following command:
rpm -ev PowerExecutive-server

Note: When you uninstall PowerExecutive, the PowerExecutive Database
is preserved.

2. Install IBM Director 5.20.x. Refer to IBM Director Installation and
Configuration Guide for details.

3. Install PowerExecutive to the latest version.

¢ On Linux, the Console properties (for example, price/kwh in the Watt-Hour
Meter dialog) are not saved across PowerExecutive sessions when the user does
not have proper authority on the operating system.

— Workaround: To save Console properties across PowerExecutive sessions,
ensure that the operating-system account you use has local root authority.

Contacting customer support

If you need help, service or technical assistance, or just want more information
about IBM products, you can find a wide variety of sources available from IBM to
assist you. This section contains information about where to go for additional
information about IBM and IBM products, what to do if you experience a problem
with your System x system, and whom to call for service, if it is necessary.

Before you call

Before you call IBM, make sure that you have taken these steps to try to solve the
problem yourself:
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* Check all cables to make sure that they are connected.
* Check the power switches to make sure that the system is turned on.

* Use the troubleshooting information in your system documentation, and use the
diagnostic tools that come with your system. Information about diagnostic tools
is in the Hardware Maintenance Manual and Troubleshooting Guide in the IBM
System x Documentation or at the IBM Systems: Technical support
sitgwww.ibm.com /jct01004c/systems /support /|

* Go to the IBM Support Web site to check for technical information, hints, tips,
and new device drivers or to submit a request for information.

You can solve many problems without outside assistance by following the
troubleshooting procedures that IBM provides in the online help or in the
publications that are provided with your system and software. The information
that comes with your system also describes the diagnostic tests that you can
perform. Most IBM System x machines, operating systems, and programs come
with information that contains troubleshooting procedures and explanations of
error messages and error codes. If you suspect a software problem, see the
information for the operating system or program.

the documentation

Information about your IBM System x machine and preinstalled software, if any, is
available in the documentation that is included with your system. That
documentation includes printed books, online books, readme files and help files.
See the troubleshooting information in your system documentation for instructions
for using the diagnostic programs. The troubleshooting information or the
diagnostic programs might tell you that you need additional or updated device
drivers or other software. IBM maintains pages on the World Wide Web where you
can get the latest technical information and download device drivers and updates.
To access these pages, go to [www.ibm.com /jct01004c/systems/support/| and
follow the instructions. Also, you can order publications through the IBM
Publications Center at [www.elink.ibmlink.ibm.com /public/applications/|
[publications /cgibin /pbi.cgil

Getting help and information from the Web

The IBM Web site has up-to-date information about IBM System x products,
services and support. Go to [www.ibm.com/systems /x| for IBM System x
information.

You can find service information for your IBM products, including supported
options, at fwww.ibm.com/jct01004c/systems/support/|

Software service and support

Through IBM Support Line, you can get telephone assistance, for a fee, with usage,
configuration, and software problems with System x servers, workstations and
appliances. For information about which products are supported by Support Line
in your country or region, go to [www.ibm.com/services/sl/products/}

For more information about Support Line and other IBM services, go to
[www.ibm.com /jct01004c /systems /support/} or go to [www.ibm.com /planetwide /|
for support telephone numbers. In the U.S. and Canada, call 1-800-IBM-SERV
(1-800-426-7378).
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Notices & Trademarks

Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user’s responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation

North Castle Drive
Armonk, NY 10504-1785
US.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation
Licensing

2-31 Roppongi 3-chome, Minato-ku
Tokyo 106-0032, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION "AS IS"” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
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sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Corporation
MWO9A /050

5600 Cottle Road
San Jose, CA 95193
US.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

This information is for planning purposes only. The information herein is subject to
change before the products described become available.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

If you are viewing this information softcopy, the photographs and color
illustrations may not appear.

Trademarks

The following are trademarks of International Business Machines Corporation in
the United States, other countries, or both:

BladeCenter
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eServer

IBM
IntelliStation®
Netfinity
PowerExecutive
ServeRAID™
ServerProven

x System

Intel is a registered trademark of Intel Corporation or its subsidiaries in the United
States and other countries.

Java and all Java-based trademarks are trademarks of Sun Microsystems, Inc. in the
United States, other countries, or both.

Linux is a registered trademark of Linus Torvalds in the United States, other
countries, or both.

Microsoft and Windows are registered trademarks of Microsoft Corporation in the
United States, other countries, or both.

Other company, product, or service names may be trademarks or service marks of
others.
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Glossary

Terms

This topic provides definitions of terms that are
used in the PowerExecutive product.

This glossary defines technical terms and
abbreviations used in this IBM PowerExecutive
document. If you do not find the term you are
looking for, view the IBM Terminology Web site
at: Ihttp: / /www.ibm.com/ibm/ terminology|

Selection of Terms: A term is a word or group of
words to be defined. In this glossary, the singular
form of the noun and the infinitive form of the
verb are the terms most often selected to be
defined. If the term may be abbreviated, the
abbreviation is indicated. The abbreviation is also
defined in its proper place in the glossary.

A

ac See alternating current.

alternating current
An electric current that reverses its
direction at regularly recurring intervals.

B

Baseboard Management Controller
A controller that monitors system
platform management events such as fan
failure and temperature or voltage
increases, and logs their occurrence.

blade server
An IBM BladeCenter server. A
high-throughput server on a card that
supports symmetric multiprocessors
(SMP).

BladeCenter chassis
A BladeCenter unit that acts as an
enclosure. It enables the individual blade
servers to share resources such as the
management, switch, power and blower
modules.

BMC See Baseboard Management Controller.

British thermal unit
An English unit of measure for heat.

BTU  See British thermal unit.
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chassis
The metal frame in which various
electronic components are mounted.
dc See direct current.

direct current
An electric current that flows in a single
direction and at a constant voltage.

discovery
The process of finding resources within
an enterprise, including finding the new
location of monitored resources that were
moved.

E

exhaust heat index
A sensor that is derived from a number of
other physical sensors in the server, which
helps to detect temperature changes in the
exhaust area of your server. The exhaust
heat index should only be used as an
indication that the exhaust temperature is
increasing or decreasing at a rate shown
in the PowerExecutive GUIL

event An occurrence of significance to a task or
system, such as the completion or failure
of an operation. There are two types of
events: alert and resolution.

event action
The action that IBM Director takes in
response to a specific event or events

event-action plan
A user-defined plan that determines how
IBM Director manages certain events. An
event action plan comprises one or more
event filters and one or more customized
event actions.

Event Action Plan wizard
An IBM Director Console wizard that can
be used to create simple event action
plans.

event filter
A filter that specifies the event criteria for
an event action plan. Events must meet
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the criteria specified in the event filter in
order to be processed by the event action
plan to which the filter is assigned to.

extension

See IBM Director extension.

external event

group

An event generated by the MM in a
BladeCenter chassis, intercepted by IBM
Director, and communicated up to
PowerExecutive through the IBM Director
event-subscription mechanism.

A logical set of managed objects. Groups
can be dynamic, static, or task-based.

IBM Director Console

A component of IBM Director software.
When installed on a system, it provides a
graphical user interface (GUI) for
accessing IBM Director Server. IBM
Director Console transfers data to and
from the management server using
TCP/IP.

IBM Director environment

The complex, heterogeneous environment
managed by IBM Director. It includes
systems, BladeCenter chassis, software,
Simple Network Management Protocol
(SNMP) devices.

IBM Director extension

A tool that extends the functionality of
IBM Director. Some of the IBM Director
extensions are BladeCenter Management,
Capacity Manager, ServeRAID Manager,
Remote Deployment Manager, and
PowerExecutive.

IBM Director Server

The main component of IBM Director
software. When installed on the
management server, it provides basic
functions such as discovery of managed
systems, persistent storage of
configuration and management data, an
inventory database, event listening,
security and authentication, management
console support, and administrative tasks.

internal event
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An event generated internally by
PowerExecutive itself, rather than an MM,
but tracked by PowerExecutive and
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displayed to the user by the same
mechanism as MM-generated events.

L

Level-0 managed system
An IBM or non-IBM server, desktop
computer, workstation, or mobile
computer that can be managed by IBM
Director but does not have any IBM
Director software installed on it.

managed group
A group of systems or objects managed
by IBM Director.

managed object
An item managed by IBM Director. In
IBM Director Console, a managed object
is represented by an icon that shows its
type (such as chassis, cluster, system, or
scalable system).

managed object ID
A unique identifier for each managed
object. It is the key value used by IBM
Director database tables.

managed system
A system that is being controlled by a
given system management application, for
example, a system managed by IBM
Director.

management console
A system (server, desktop computer,
workstation, or mobile computer) on
which IBM Director Console is installed.

management module
The BladeCenter component that handles
system-management functions. It
configures the chassis and switch
modules, communicates with the blade
servers and all I/O modules, multiplexes
the keyboard/video/mouse (KVM), and
monitors critical information about the
chassis and blade servers.

management server
The server on which IBM Director Server
is installed.

module
A BladeCenter component that is inserted
in a bay in a chassis and whose power
consumption data can be monitored by
PowerExecutive. Modules include power



modules (power supplies), blade servers,
I/0 modules, BladeCenter management
modules, blower modules, and media
trays.

o)

out-of-band communication
Communication that occurs through a
modem or other asynchronous
connection, for example, service processor
alerts sent through a modem or over a
LAN. In an IBM Director environment,
such communication is independent of
the operating system and interprocess
communication (IPC).

R

rack-mounted server
A standalone system with a Baseboard
Management Controller (BMC).

S

switch module
The BladeCenter component that provides
network connectivity for the BladeCenter
chassis and blade servers. It also provides
interconnectivity between the
management module and blade servers.

system
The computer and its associated devices
and programs.

T

target system
A managed system on which an IBM
Director task is performed.

\'}

vital product data (VPD)
Information that uniquely defines the
system, hardware, software, and
microcode elements of a processing
system.

VPD  See vital product data.
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Index
A

accessibility  viii
keyboard  viii
shortcut keys  viii

alert-forwarding profile 33

bay 5
before you call 41
breadcrumb 5

C

chassis
displaying details 22
collect
data 30
trend 30

components 3
Connecting to
BladeCenter chassis 19
rack-mounted servers 19
contacting customer support 41
critical events 33
current data
exporting 32
Current Data pane 6
displaying 9
custom time interval 31
customer support
contact 41

D

data
collection 30
resuming 10, 30
suspending 10, 30
trend data 30
exporting 32
derating power factor 29
details, displaying 19
chassis 22
group of chassis 20
modules 24
power domains 23
Director console 13
disability viii
displaying details
power-managed rack-mounted
servers 26

unmanaged rack-mounted servers 27

downloading PowerExecutive 15

E

Embedded Director 13
Embedded Director console 13
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estimating

power consumption 29
events

refresh operations 33

Trend Data pane 35
events that affect PowerExecutive 33
export

current data 32

data 32

Trend Data chart 32

Trend Data table 32

G

getting help 42
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group of chassis
displaying details 20

H

hardware
requirements 13
hardware requirements
managed systems 13
management consoles 13
management servers 13

IBM Web sites vii

installation 13, 15, 17
downloading PowerExecutive 15
prerequisites 14

K

keyboard viii

L

legal notices 43

M

manage power 10
manage trend data window 30
management module power displays
Management Processor Assistant 33
module 5
modules

displaying details 24
monitoring power consumption 19

N

Navigation pane 5
displaying 9

o)

operating system
supported 14

P

Pcap setting 28
polling interval 30
power domains
displaying details 23
Power Executive
components of 1
concepts 1
documentation vii
getting started 1
overview 1
Power Executive window
customizing 9
Navigation pane 5
Trend Data pane 7
power factor
derating 29
power meter
displaying 9, 10
power policy 28
Power Policy dialog 28
PowerExecutive
Database 3
overview 1
prerequisites 14
uninstalling
Linux 18
Windows 18
PowerExecutive console
events 33
PowerExecutive Console 3
PowerExecutive custom window 31
PowerExecutive Derate Power Factor
window 29
PowerExecutive Server 3

PowerExecutive stand-alone version 13

PowerExecutive task 4
overview 1

PowerExecutive window 5
Current Data pane 6
refreshing 10

Preparing to install PowerExecutive 14

problem solving 39

R

refresh 10
refreshing
PowerExecutive console 10
requirements 13
hardware 13
resume
data collection 10, 30
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server configuration manager events 33

set

power capping 28
setting

power policy 28
shortcut keys viii
software service and support 42
solving problems 39
stand-alone 13
Starting PowerExecutive

all managed systems 5

some managed systems 5
summary, displaying 19
suspend

data collection 10, 30
system events 33
System x

documentation 42
systems running Linux 17
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trend chart 7

Trend Data as Chart
exporting Trend Data chart 32

Trend Data chart 7
exporting 32

Trend data graph
displaying 10

Trend Data graph
displaying 9

Trend Data pane 7
custom time interval 31
displaying 9
events 35
predefined time intervals 7

Trend data table
displaying 10

Trend Data table 7
displaying 9
exporting 32

troubleshooting 39
known problems 39
limitations 39
workarounds 39

U

understanding differences between
PowerExecutive and management
module power displays 20
uninstalling PowerExecutive
Linux 18
Windows 18
using PowerExecutive 19

W

warning events 33
Watt-Hour Meter
using 38

Web
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